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Matching SCE Trainer Packages for this Learn-/Training Document 

 

SINAMICS S210 Frequency converter 

• SINAMICS S210 Servo drive for 1 AC 200 - 240 V with PROFINET 

Order no.: 6SL3080-8BB00-0AA0 

 

Alternative: 

• SINAMICS S210 Servo drive for 3 AC 380 - 480 V with PROFINET, exclusively with S7-1500 

Order no.: 6SL3080-8BE00-0AA0 

 

SIMATIC controllers 

• SIMATIC ET 200SP Open Controller CPU 1515SP PC2 F with WinCC RT Advanced 512 PTs 

Order no.: 6ES7677-2SB42-4AB1 

• SIMATIC ET 200SP Distributed Controller CPU 1512SP F-1 PN Safety 

Order no.: 6ES7512-1SK00-4AB2 

• SIMATIC CPU 1516F PN/DP Safety 

Order no.: 6ES7516-3FN00-4AB2 

• SIMATIC S7 CPU 1516-3 PN/DP 

Order no.: 6ES7516-3AN00-4AB3 

• SIMATIC CPU 1512C PN with software and PM 1507           

Order no.: 6ES7512-1CK00-4AB1 

• SIMATIC CPU 1512C PN with software, PM 1507 and CP 1542-5 (PROFIBUS) 

Order no.: 6ES7512-1CK00-4AB2 

• SIMATIC CPU 1512C PN with software 

Order no.: 6ES7512-1CK00-4AB6 

• SIMATIC CPU 1512C PN with software and CP 1542-5 (PROFIBUS) 

Order no.: 6ES7512-1CK00-4AB7 

 

SIMATIC STEP 7 Software for Training   

• SIMATIC STEP 7 Professional V16 - Single license 

Order no.: 6ES7822-1AA06-4YA5 

• SIMATIC STEP 7 Professional V16 - Classroom license for 6 users  

Order no.: 6ES7822-1BA06-4YA5 

• SIMATIC STEP 7 Professional V16 - Upgrade license for 6 users 

Order no.: 6ES7822-1AA06-4YE5 

• SIMATIC STEP 7 Professional V16 - Student license for 20 users 

Order no.: 6ES7822-1AC06-4YA5 

 

Note that these trainer packages will be replaced with successor packages when required. 

You can find an overview of the currently available SCE packages at: siemens.com/sce/tp 

 

Further education 
Get in touch with your regional SCE contact for information on regional Siemens SCE in-service training 

courses siemens.com/sce/contact 

 

Further information on SCE  

siemens.com/sce 

  

http://www.siemens.com/sce/tp
http://www.siemens.com/contact
http://www.siemens.com/contact
http://www.siemens.com/sce
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Notes on use 

The SCE Learn-/Training Document for the integrated automation solution Totally Integrated Automation (TIA) 

was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for training 

purposes for public educational facilities and R&D institutions. Siemens does not guarantee the contents. 

  

This document is only to be used for initial training on Siemens products/systems. This means it can be 

copied in whole or in part and given to trainees/students for use within the scope of their training/course of 

study. Disseminating or duplicating this document and sharing its content is permitted within public training 

and advanced training facilities for training purposes or as part of a course of study. 

 

Exceptions require written consent from Siemens. Send all related requests to  

scesupportfinder.i-ia@siemens.com. 

 

Offenders will be held liable. All rights including translation are reserved, particularly if a patent is granted or a 

utility model or design is registered. 

 

Use for industrial customer courses is explicitly not permitted. We do not consent to commercial use of the  

Learn-/Training Document. 

 

We wish to thank the Michael Dziallas Engineering Corporation and all other involved persons for their support 

during the preparation of this Learn-/Training Document. 

 

mailto:scesupportfinder.i-ia@siemens.com
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Servo drive system S210 PN on  
PROFINET IRT with technology objects 
in SIMATIC S7-1500 

1 Objective 

In this chapter, you will learn how a SINAMICS S210 PN frequency converter can be commissioned 

with a SIMATIC S7 controller – based on the example of a CPU1516F-3 PN/DP with PROFINET 

IRT (Isochronous Real Time). 

The module explains the commissioning of the SERVO drive system S210 PN with the SINAMICS 

Startdrive software in the TIA Portal.  

Subsequently, we show step-by-step how the servomotor from the program of the CPU1516F-3 

PN/DP can be controlled and monitored via technology objects. 

The SIMATIC S7 controllers listed in chapter 3 can be used. 

2 Requirement 

This chapter builds on the chapter "Global data blocks" of SIMATIC S7. 

To implement this chapter, you can use the following project, for example:  

"032-600-global-data-blocks ...". 

3 Hardware and software required 

1 Engineering station: Hardware and operating system requirements apply  

(for additional information, see Readme on the TIA Portal Installation DVDs) 

2 SIMATIC STEP 7 Professional software in the TIA Portal – as of V16 

3 SINAMICS Startdrive software in the TIA Portal – as of V16 

4 SIMATIC S7-1500 controller, e.g. CPU 1516F-3 PN/DP – as of firmware V2.8 with memory 

card and 16DI/16DO  

Note: The digital inputs should be fed out to a control panel. 

5 Servo drive system: 

- SINAMICS S210 frequency converter with memory card 

- SIMOTICS S-1FK2 electric motor 

- OCC MOTION-CONNECT cable 

6 Ethernet connection between the engineering station and controller and between the controller 

and frequency converter 
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2 SIMATIC STEP 7 

Professional (TIA Portal) 

as of V16 

 

3 SINAMICS Startdrive 

(TIA Portal) as of V16 

 

 

 

1 Engineering station 

6 Ethernet connection 

6 Ethernet connection 

 

5 Servo drive system: 

- SINAMICS S210 frequency converter with memory card 

- SIMOTICS S-1FK2 motor 

- OCC MOTION-CONNECT cable 

Control panel 
 

4 SIMATIC S7-1500 controller 
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4 Theory 

4.1 System overview 

 

1. Fuse or circuit breaker 2. Line contactor (optional) 

3. Line filter (optional) 4. External braking resistor (optional) 

5. Shaft sealing ring for IP65 (optional) 6. 1FK2 servo motor 

7. OCC extension cable (optional) 8. Mounting for control cabinet bushing 

(optional) 

9. OCC connection cable for motor, motor 

holding brake and encoder 

10. Shielding terminal 

11. Shield plate 12. 24 V power supply 

13. SD memory card (optional) 14. Commissioning device, e.g. laptop 

15. Controller, e.g. SIMATIC S7-1500  
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4.2 Converter connections and operator controls 

 

4.3 OCC connecting cable 

 

1. M12 or M17 round connector, 10-pin 2. MOTION-CONNECT OCC cable 

3. Shielding 4. Cables for holding brake 

5. Power cables 6. SIEMENS IX connector for signal line 

 

For details, see the manuals at support.automation.siemens.com.  

file:///C:/arbeit/00_GJ20_21/Schmitt/Review%20SCE%20Lern-Lehrunterlage%20S210/support.automation.siemens.com/
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4.4 Safety measures and warnings 

The following safety information and warnings are to be observed before the installation and 

commissioning of the SINAMICS S210. 

4.4.1 General 

 

 

 

 

Note:  

– It is assumed that a ready pre-assembled converter unit with servo motor is being used for the 

following operating steps and tasks. Observe the safety regulations and warnings of the 

manufacturers when carrying out the electrical installation. Instructions and directives for 

mounting and electrical installation can be found in the manuals of the SINAMICS S210. 
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4.5 Telegrams 

Various telegrams, whose process data lengths and contents differ, are available for selection for 

IRT communication with the frequency converter. 

Standard telegram 5 is used here. 

4.5.1 Process data (PZD) for SINAMICS S210 with standard telegram 5 

Control words and setpoints (PLC -> SINAMICS) or status words and actual values (SINAMICS -

> PLC) can be transferred with the process data. The structure of the PZD area is as follows for 

Telegram 5, for a coupling via PROFINET: 

 Request frame 

(SPS -> SINAMICS) 

Response frame 

(SINAMICS -> SPS) 

PZD1 Control word 1 

(STW1) 

Status word 1 

(ZSW1) 

PZD2 

 

PZD3 

 

Speed setpoint B (32 bits) 

(NSOLL_B) 

Actual speed value B (32 bits) 

(NIST_B) 

PZD4 Control word 2 

(STW2) 

Status word 2 

(ZSW2) 

PZD5 Control word of encoder 1 

(G1_STW) 

Status word of encoder 1 

(G1_ZSW) 

PZD2 

 

PZD3 

 

Position deviation 

(XERR) 

Actual position value 1 of encoder 1 

(G1_XIST1) 

PZD2 

 

PZD3 

 

Gain factor for the position controller 

(KPC). 

Actual position value 2 of encoder 1 

(G1_XIST2) 
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4.5.2 Control word 1 (STW1) 

Bit Meaning 

00 ON/OFF1 

01 OFF2 

02 OFF3 

03 Enable operation 

04 Disable ramp-function generator 

05 Reserved 

06 Enable speed setpoint 

07 Acknowledge fault 

08 Reserved 

09 Reserved 

10 Control by PLC 

11 Reserved 

12 Open holding brake 

13 Reserved 

14 Torque/speed control 

15 Reserved 

 

4.5.3 Status word 1 (ZSW1) 

Bit Meaning 

00 Ready for switch-on 

01 Ready 

02 Operation enabled 

03 Fault present 

04 No coasting active 

05 No quick stop active 

06 Switching on inhibited active 

07 Alarm present 

08 Controller enable 

09 Control requested 

10 Comparison value reached/exceeded 

11 Alarm class bit 0 

12 Alarm class bit 1 

13 Reserved 

14 Torque control active 

15 Reserved 
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4.5.4 Speed setpoint B 32 bits (NSOLL_B) 

The speed setpoint B (NSOLL_B) is a 32-bit word in which the required speed setpoint is 

transferred to the converter. 

The setpoint is transferred as a signed integer. Bit 31 defines the sign of the setpoint as follows: 

– Bit = 0 --> Positive setpoint 

– Bit = 1 --> Negative setpoint 

Value 1 073 741 824 (4000 0000 Hex) corresponds to the speed in parameter p2000.  

In our application, the value 7300 rpm is in parameter p2000. 

The current speed setpoint is calculated as follows: 

n_set = (NSOLL_B x p2000)/1 073 741 824 

4.5.5 Actual speed value B 32 bits (NIST_B) 

The actual speed value is a 32-bit word through which the speed of the converter is transferred. 

The scaling of this value corresponds to that of the setpoint NSOLL_B. 

4.5.6 Control word 2 (STW2) 

Bit Meaning 

00 Reserved 

01 Reserved 

02 Reserved 

03 Reserved 

04 Reserved 

05 Reserved 

06 Integrator disable, speed controller 

07 Parking axis selection 

08 Travel to fixed stop 

09 Reserved 

10 Reserved 

11 Reserved 

12 Controller sign-of-life bit 0 

13 Controller sign-of-life bit 1 

14 Controller sign-of-life bit 2 

15 Controller sign-of-life bit 3 
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4.5.7 Status word 2 (ZSW2) 

Bit Meaning 

00 Reserved 

01 Reserved 

02 Reserved 

03 Reserved 

04 Reserved 

05 Open holding brake 

06 Integrator disable, speed controller 

07 Parking axis active 

08 Travel to fixed stop 

09 Reserved 

10 Reserved 

11 Reserved 

12 Device sign-of-life bit 0 

13 Device sign-of-life bit 1 

14 Device sign-of-life bit 2 

15 Device sign-of-life bit 3 

 

4.5.8 Encoder 1 control word (G1_STW) 

Bit Meaning 

00 Request function 1 

01 Request function 2 

02 Request function 3 

03 Request function 4 

04 Request command bit 0 

05 Request command bit 1 

06 Request command bit 2 

07 Mode 

08 Reserved 

09 Reserved 

10 Reserved 

11 Reserved 

12 Reserved 

13 Request absolute value cyclically 

14 Request parking encoder 

15 Acknowledge encoder fault 
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4.5.9 Encoder 1 status word (G1_ZSW) 

Bit Meaning 

00 Function 1 active 

01 Function 2 active 

02 Function 3 active 

03 Function 4 active 

04 Value 1 

05 Value 2 

06 Value 3 

07 Value 4 

08 Measuring input 1 displaced 

09 Measuring input 2 displaced 

10 Reserved 

11 Encoder error acknowledgment active 

12 Reserved 

13 Absolute value cyclic  

14 Parking encoder active 

15 Encoder error  

 

4.5.10 Position deviation (XERR) 

Position deviation is transferred as right-aligned 32-bit binary value via signal XERR. 

4.5.11 Actual position value 1 of encoder 1 (G1_XIST1) 

The current incremental actual position of the measuring system without sign is output as a right-

aligned 32-bit binary value via signal G1_XIST1. 

4.5.12 Gain factor for the position controller (KPC) 

The gain factor for the position controller is transferred as a right-aligned 32-bit binary value via 

signal KPC. 

4.5.13 Actual position value 2 of encoder 1 (G1_XIST2) 

The current scaled absolute actual position of the measuring system without sign is output as a 

right-aligned 32-bit binary value via signal G1_XIST2. 
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4.6 SINAMICS Startdrive commissioning tool for SINAMICS S210 

The most recent version of the SINAMICS Startdrive commissioning software can be downloaded 

from the website:  

support.industry.siemens.com . 

SINAMICS Startdrive is a tool integrated in TIA Portal and corresponds to the familiar TIA Portal in 

its structure and handling. 

The SINAMICS Startdrive extension contains the data and views for the SINAMICS S210 

frequency converters already supported there.  

This enables easy parameter assignment and commissioning of the frequency converters. A wide 

range of functions and aids are available for diagnostics and troubleshooting. 

4.6.1 Resetting frequency converters and setting the IP address  

A new IP address can be directly assigned to the Control Unit of the frequency converter with 

SINAMICS Startdrive in TIA Portal. The Control Unit can now be reset. 

→ Open the Totally Integrated Automation Portal with a double click.  

(→ TIA Portal V16).  

 

→ Select the item → "Online & Diagnostics" and open the → "Project view". 

 

https://support.industry.siemens.com/
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→ In the project tree, select the network card of your computer under → "Online access". When 

you click → "Update accessible devices", you see the IP address (if already set) or the MAC 

address (if the IP address has not yet been assigned) of the Control Unit of the connected 

SINAMICS S210 frequency converter →. Select → "Online & diagnostics".  
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→ Before you reassign the IP address, we recommend that you first reset the PROFINET interface 

parameters. To do so, select the function → "Reset of PROFINET interface parameters" and 

click → "Reset". 

 

 

→ Confirm the prompt "Do you really want to reset the module?" with → "Yes" 

 

→ Successful resetting can be checked under "Show all messages" in the → "Info" window → 

"General". 
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→ Then once again select → "Update accessible devices" and then → "Online & diagnostics" of 

your frequency converter. To assign the IP address, select the → "Assign IP address" function. 

Enter the following IP address at this point, for example: → IP address: 192.168.0.21 → Subnet 

mask: 255.255.255.0. Click → "Assign IP address" and this new address is assigned to the 

Control Unit of your frequency converter.  

 

→ The successful assignment of the IP address is shown again as a message in the window → 

"Info" → "General". 
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4.6.2 Restoring the factory setting of the SINAMICS S210  

→ Before you can now carry out resetting of the frequency converter to the factory settings, you 

must once again select → "Update accessible devices" and the → "Online & diagnostics" of 

your frequency converter. In order to reset the frequency converter to factory settings, select 

→ "Restore factory setting" under → "Backup/Restore" and click → "Start". 

 

→ Select the option  "Also save RAM data retentively" and confirm the prompt asking whether 

you really want to restore the factory settings with → "OK".  

 

 

Note:  

– The communication settings such as the IP address and the subnet mask are retained when 

the frequency converter is reset to the factory settings. 
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4.6.3 Reading out the firmware version and order number of the SINAMICS 

S210  

→ Before you can read out the firmware version and order number of the SINAMICS S210, you 

must select → "Update accessible devices" again and select → "Online & diagnostics" of the 

SINAMICS S210. In the menu item → "Diagnostics" → "General", you can read out the short 

designation, article number, hardware version and firmware version. 
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5 Task 

In the following section, the project from the chapter "032-600_Global_Data_Blocks" is to be 

supplemented by a frequency converter S210. 

It should be possible to quickly and precisely set two different positions of the magazine for plastic 

parts at the conveyor end using a servo positioning unit.  

Control of the servo drive is realized with a technology object via PROFINET IRT. 

 

6 Planning 

The positioning unit driven by a servo motor is controlled by a SINAMICS S210 frequency 

converter. 

This frequency converter must be created, configured and commissioned in the project. 

The parameter assignment of the frequency converter is done online with the SINAMICS Startdrive 

software, whereby the basic data is read in from the Control Unit. 

The motor data of the servo motor and the encoder data is detected automatically via the DRIVE-

CLiQ interface. 

The frequency converter is controlled via PROFINET IRT with the motion control technology object 

"TO_PositioningAxis". This must be created, connected with the S210 servo drive and assigned 

parameters. 

Then, a library-capable "MC_magazine" function block is created via which the following motion 

control instructions can be performed: 

– Acknowledgment of an error 

– Jog UP (speed positive/right) / DOWN (speed negative/left) 

– Home to fixed stop (bottom) with definition of home position 

– Position to Position00 with specification of position value 

– Position to Position01 with specification of position value 

– Position to Position02 with specification of position value 

 

When the "MC_magazine" function block is called in the organization block "Main" [OB1], the home 

position and the position values are specified as fixed values. 

The start commands are interconnected to inputs. 
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6.1 Technology schematic diagram 

At this point, you see the technology schematic diagram for the task. 

 

Figure 3: Technology schematic diagram 

 

Figure 4: Operator panel 
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6.2 Reference table 

The following signals are required as global operands for this task. 

DI Type Identifier Function NC/NO 

I 0.0 BOOL -A1 Message EMERGENCY STOP ok NC 

I 0.1 BOOL -K0 System "ON" NO 

I 0.2 BOOL -S0 Mode selector manual (0) / automatic (1) 

Manual = 
0 

Auto=1 

I 0.3 BOOL -S1 Pushbutton automatic start NO 

I 0.4 BOOL -S2 Pushbutton automatic stop NC 

I 0.5 BOOL -B1 Sensor cylinder -M4 retracted NO 

I 1.0 BOOL -B4 Sensor part at slide NO 

I 1.3 BOOL -B7 Sensor part at end of conveyor NO 

I 2.0 BOOL -S10 Acknowledgment button NO 

I 2.1 BOOL -S11 Jog up button NO 

I 2.2 BOOL -S12 Jog down button NO 

I 2.3 BOOL -S13 Set home position button NO 

I 2.4 BOOL -S14 Start positioning to Position00 button NO 

I 2.5 BOOL -S15 Start positioning to Position01 button NO 

I 2.6 BOOL -S16 Start positioning to Position02 button NO 

 

Legend for reference list 

 

 

 

 

 

 

 

 

DO Digital output 

AO Analog output 

O Output 

DI Digital input 

AI Analog input 

I Input 

NC Normally Closed 

NO Normally Open 
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7 Structured step-by-step instructions 

You can find instructions on how to perform planning below. If you already have a good 

understanding of everything, it is enough to focus on the numbered steps. Otherwise, simply follow 

the steps of the instructions illustrated below. 

 

7.1 Retrieving an existing project 

→ Before we can extend the project "032-600-Global-Data-Blocks…" from chapter 

"032-600_Global_Data_Blocks", we must retrieve it. To retrieve an existing project, you must 

select the respective archive from the Project view under → Project → Retrieve. Confirm your 

selection with Open. (→ Project → Open → Selection of a .zap archive → Open) 

 

 

→ Next, the target directory in which the retrieved project is to be stored can be selected. Confirm 

your selection with "OK". (→ Target directory → OK) 
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→ You save the opened project under the name "062-121 Servo S210 IRT TO S7-1500".  

(→ Project → Save as… → 062-121 Servo S210 IRT TO S7-1500 → Save) 
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7.2 Creating a servo drive system in the TIA Portal 

→ In order to network the servo drive system of the SINAMICS S210 with the CPU1516F-3 PN/DP 

you must change to the 'Network view'. At this point, the desired  

'SINAMICS S210' can be dragged-and-dropped into the network view.  

(→ Devices & networks → Network view → Drives & starters → SINAMICS drives → 

SINAMICS S210 → 200-240 V 1AC, 0.4 kW → article no.: 6SL3210-5HB10-4xFx →  

Version 5.2). 
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→ Then you set an IP address suitable for the CPU in the properties of the 'PROFINET interface 

[X1]' of the 'S210 PN‘. (→ S210 PN → PROFINET interface[X1] → Properties → Ethernet 

addresses → IP protocol → IP address: 192.168.0.21) 
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7.3 Reading in data of the servo motor and encoder data via DRIVE-

CLiQ interface 

→ The motor data of the servo motor and the encoder data is detected automatically via the 

DRIVE-CLiQ interface at X100 during startup with the compact servo drive system S210 PN. 

This data can be simply uploaded from the Control Unit S210 PN. 

(→ Drive unit_1 →  Upload from device) 

 

 

Note:  

– During the boot procedure, the SINAMICS S210 reads in the electronic motor rating plate of 

the connected 1FK2 motor and performs motor commissioning. Without a motor, motor 

commissioning and therefore automatic commissioning cannot be completed. Parameter 

assignment of the converter is not possible in this state. Therefore, only a small number of 

functions such as diagnostics or reset are available. 

 

→ In the following dialog, you now select the settings of the PG/PC interface and click on 'Start 

search'. You should now see your 'SINAMICS drive' and be able to select it as the target 

device. Click 'Load'. (→ Type of the PG/PC interface: PN/IE → PG/PC interface: …… → 

Connection to subnet: Directly at slot 'CU X150' → Start search → S210 PN → Upload) 
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Note 

– Although the PROFINET interface parameters were reset and the drive restored to factory 

settings previously, it is possible that the module name of a previous configuration is still 

retained and is now assigned as device name. We will change this later. 
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→ Motor and encoder are now displayed in the device configuration. Save the project with the 

data you just loaded. (→ Device configuration → ) 
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7.4 Details on motor and encoder 

→ The selected motor can be displayed in the properties of the device configuration. (→ Device 

configuration → Properties → General → Motor - selection - 1FK2) 

 

→ The details on the detected motor can be displayed here. (→ Device configuration → Properties 

→ General → Motor details) 
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→ Details on the encoder can also be displayed here. (→ Device configuration → Properties → 

General → Encoder_4 → General → Measuring system – Selection – Drive-CliQ) 
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→ Measuring system details are available in a further submenu. (→ Device configuration → 

Properties → General → Encoder_4 → General → Measuring system details) 

 

→ The encoder evaluation unit is also shown here. (→ Device configuration → Properties → 

General → Encoder_4 → SMXX_3) 
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7.5 Parameterizing the drive 

→ To assign the further parameters of the frequency converter, we open the 'Parameters' of 

'Drive_S210... [S210 PN]' with a double-click and select the 'Basic parameterization' in the 

'Function view'. Here, we first adapt the 'Motor ambient temperature' and the limits. (→ 

Drive_S210…[S210 PN] → Parameterization → Function view → Basic parameterization → 

Motor → Motor ambient temperature: 25°C → Limits) 
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→ The settings for 'Safety Integrated" and the "Inputs/outputs" can be made in the 'Function view'. 

(→ Drive_S210…[S210 PN] → Parameters → Function view → Safety Integrated → 

Inputs/outputs → Digital inputs) 

 

→ In the 'Parameter view', all parameters can be viewed in different lists and changed 

depending on access rights and the status of the drive. (→ Parameter view) 
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→ We now save the project again before we load the parameters into 'Drive_S210… [S210 PN]’‚

‘.  (→ → Drive_S210…[S210 PN] → ) 

 

→ An overview is now displayed again so that you can check the steps to be carried out before 

loading. Now select '  Save parameterization retentively' and click 'Load'. (→  Save 

parameterization retentively → Load) 

 

Note 

– It is advisable to save the parameters retentively as well, so that these are retained in the case 

of a voltage drop. 
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7.6 Testing and commissioning of frequency converters with control 

panel 

→ In order to test the current parameter assignment without PLC program, open the 'Control 

panel' from the 'Commissioning' menu of the 'Drive_S210… [S210 PN]'. Finally, we click on '

 '. (→ Drive_S210…[S210 PN] → Commissioning → Control panel → ) 
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→ The first step is to 'Activate master control ' in the control panel. The communication 

between the PC and the converter will then be monitored. It is necessary that successful 

communication takes place at least every 10000 ms. Otherwise, the motor stops and the 

enables are reset. (→ Master control:  → 10000ms → OK) 

 

→ The drive enables first have to be set in order to start the motor . As a rule, this 

happens automatically. We can now start the motor with the selected speed  or 

. (→ Speed: 1000.00 rpm → ) 
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→ The drive can be switched off by clicking ' '. After completion of the test, it is necessary to 

deactivate  the master control again. (→  → ) 
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→ Finally, we ' ' and save the project again ' '.  

(→  → ) 
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7.7 Assigning the servo drive of the CPU1516F-3 PN/DP as IRT device 

→ To assign the SINAMICS S210 to the CPU1516F-3 PN/DP as IRT device, you need to change 

to the 'Network view'. Here, you connect the Ethernet interfaces of the Control Unit of the S210 

PN and the CPU1516F-3 PN/DP with the mouse. (→  Ethernet →  Ethernet) 
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→ Another requirement for an IRT connection is a defined assignment of the ports on the Control 

Unit of the S210 PN to the ports on the CPU1516F-3 PN/DP. Here we connect Port1 in each 

case with the mouse. (→ Topology view →  Port_1 →  Port_1) 

 

→ Details on the topological assignment can be displayed in the 'Topology overview'. (→ 

Topology view → Topology overview) 
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→ Back in the 'Network view', the device name is assigned to the drive under 'General'.  

(→ Network view → General → Name: Drive_S210_magazine)  

 

→ Make sure that this name is applied automatically as the PROFINET device name under the 

'PROFINET' item for the 'PROFINET interface' of the 'S210 PN'. (→ PROFINET interface → 

Ethernet addresses → PROFINET →  Generate PROFINET device name automatically)  
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The 'Real time settings' of the 'PROFINET interface' can now be made. With this application, the 

'IRT‘(Isochronous Real Time) RT class is first selected for synchronization and the domain settings 

are made. (→ PROFINET interface → Advanced options → Real time settings → Synchronization 

→ RT class:  IRT → Domain settings → cpu_1516f.profinet-interface_1: SyncMaster → Send 

clock: 2.000 ms) 
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→ Isochronous mode now needs to be set for the 'Drive_S210_magazine ‘.  

(→ Drive_S210_magazine → PROFINET interface → Advanced options → Isochronous mode 

→  Isochronous mode) 

 

 

  



SCE Learning/Training Document | TIA Portal Module 062-121, Edition 09/2020 | Digital Industries, FA 

 

Unrestricted use in educational / R&D institutions. © Siemens 2020. All rights reserved.                                      47 

sce-062-121-servo-s210-pn-irt-to-s71500-r2008-en.docx  

→ The 'Standard telegram 5' is specified for the 'Cyclic data exchange' between the PLC and the 

frequency converter. (→ PROFINET interface [X150] → Cyclic data exchange → Send (Actual 

value): Standard telegram 5 → Receive (Setpoint): Standard telegram 5) 
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→ For the address ranges, we select 'I 256…264' and 'Q 256 … 264'.  

(→ PROFINET interface [X150] → Cyclic data exchange → Send (Actual value) → Start 

address I 256 → Receive (Setpoint) → Start address Q 256) 
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→ An isochronous organization block still needs to be assigned for the 'Drive_S210_magazine' is 

isochronous mode. The option 'Add new and open' should be deselected . (→ PROFINET 

interface[X150] → Cyclic data exchange → Send (Actual value) → Organization block → 

 → MC-Servo →  Add new and open → OK) 
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→ The isochronous organization block is automatically also assigned to the receive telegram. 

Now we save the project with the existing settings. (→ PROFINET interface [X150] → Cyclic 

data exchange → Receive (Setpoint) → Organization block → MC-Servo→ ) 
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7.8 Creating a technology object in CPU1516F-3 PN/DP 

→ To control the positioning application in the servo drive, we create a new technology object in 

the CPU1516F-3 PN/DP. We select the object 'TO_PositioningAxis' under 'Motion Control ‘.  

(→ CPU1516F-3 PN/DP → Technology objects → Add new object → Motion Control → 

TO_PositioningAxis → PositioningAxis_magazine → OK) 
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→ Now the 'Function view' for the technology object opens automatically. Here, we first select the 

'Basic parameters' displayed here. (→ Function view → Basic parameters) 
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→ Next, we select the 'Drive control' in our 'Drive_S210_magazine‘ as 'Hardware interface‘ for the 

technology object. (→ Hardware interface → Drive → PROFINET IO system(100) → 

Drive_S210_magazine → Drive control → ) 
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→ The encoder data is applied automatically. (→ Hardware interface → Encoder) 

 

→ We retain the values for data exchange with the drive. (→ Hardware interface → Data 

exchange with the drive) 
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→ We retain the values for data exchange with the encoder. (→ Hardware interface → Data 

exchange encoder) 

 

→ Adaptation to the specific 'Drive mechanism' can be performed under 'Extended parameters'. 

Here we select the settings shown. (→ Extended parameters → Mechanics → Drive 

mechanism) 
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→ Settings on mechanics, dynamic default values, limits, reference settings, position monitoring 

etc. can be made under 'Extended parameters'. (Extended parameters → Dynamic default 

values → …) 

 

 

Note:  

– You can find more precise information on the individual settings in the online help and the 

manuals. 
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7.9 Loading CPU1516F-3 PN/DP and assigning a device name to the 

drive 

→ We now save the project and load the CPU1516F-3 PN/DP with the device configuration, the 

frequency converter S210 PN as device and the technology object into the 'CPU_1516F 

[CPU1516F-3 PN/DP]'. (  →CPU_1516F [CPU1516F-3 PN/DP] → ) 
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→ The device name still must be assigned to the frequency converter S210 as an IO device of 

the CPU_1516F. To do so, we first select the 'Drive_S210_magazine' network and click on '

 Assign device name'. (→ Drive_S210_magazine →  Assign device name) 
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→ In the subsequent dialog, the 'PG/PC interface' can be selected before we select the 

'drive_s210_magzine' and 'Assign name'. (→ PROFINET device name: Drive_s120_magazine 

→ SINAMICS S210 → Assign name) 

 

Note:  

– If several IO devices exist in the network, the device can be identified on the basis of the 

imprinted MAC address or by 'Flash LED'. 
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→ If too many components are displayed, the view can be filtered by clicking on 'Only show 

devices of the same type'. If the device name was assigned successfully, this is indicated by 

'OK' in the status. (→ Close) 
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7.10 Testing and commissioning the technology object  

→ To be able to test the technology object, we open the 'Axis control panel' from the 

'Commissioning' menu for the 'PositioningAxis_magazine' technology object and

 master control there. (→ CPU_1516F [CPU1516F-3 PN/DP] → Technology 

objects → PositioningAxis_magazine → Commissioning → Axis control panel → Master 

control:  → 2000ms → OK) 
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→ For this purpose, we first have to ' ' the axis to start the motor. We can 

 pending errors here. (→ Axis:  → Pending errors: 

) 

 

→ We can then start the motor with the selected speed  or  and pause 

it with . (→ Speed: 500.0 mm/s →  → ) 
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→ Before we can perform absolute commissioning, we need to 'Set home position'. This is done 

by setting a position value at a specific position, preferably a fixed stop. (→ Operating mode: 

Set home position → Control → Position 0.0 mm → ) 
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→ If the axis is homed, this is shown in the axis control panel. Absolute positioning can now be 

started with the values shown here and monitored.  

(→ Operating mode: Absolute positioning → Target position: 1000.0 mm → Velocity: 500.00 

→ ) 
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→ We can disable the technology object again by clicking on ' '. After completion 

of the test, it is necessary to ' ' the master control again. (→  → 

) 
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→ Finally, we need to ' ' and save the project again ' '. (→  → 

) 
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7.11 Creating a program for controlling the servomotor 

→ We now want to create the program to control the servo motor. Beforehand,  

we will create a 'Tag table_servo_magazine' with the tags shown here. (→ CPU_1516F 

[CPU1516F-3 PN/DP] → PLC tags → Add new tag table → Tag table_servo_magazine) 
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→ Next, we create the 'MOTION_CONTROL_MAGAZINE' function block. (→ Add new block → 

FB → MOTION_CONTROL_MAGAZINE → FBD → OK) 
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→ As shown here, declare the interface of the 'MOTION_CONTROL_MAGAZINE' function block. 

(→ 'MOTION_CONTROL_MAGAZINE' [FB2] → Block interface) 
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→ Using drag-and-drop, drag the 'MC_RESET' command from the 'Motion Control' point under 

the 'Technology' instructions into the first network and create the 'MC_RESET_Instance' multi-

instance. (→ Instructions → Technology → Motion Control → MC_RESET → Multi-instance → 

MC_RESET_Instance → OK) 
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→ Label the network 1 and connect the 'MC_RESET' block as shown below.  

 

→ In network 2, program the call of the 'MC_POWER' block with multi-instance as shown here. 

(→ Instructions → Technology → Motion Control → MC_POWER) 
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→ In network 3, program the call of the 'MC_MOVEJOG' block with multi-instance as shown here. 

(→ Instructions → Technology → Motion Control → MC_MOVEJOG) 

 

→ In network 4, program the call of the 'MC_HOME' block with multi-instance as shown below. 

(→ Instructions → Technology → Motion Control → MC_HOME) 

 

  



SCE Learning/Training Document | TIA Portal Module 062-121, Edition 09/2020 | Digital Industries, FA 

 

Unrestricted use in educational / R&D institutions. © Siemens 2020. All rights reserved.                                      73 

sce-062-121-servo-s210-pn-irt-to-s71500-r2008-en.docx  

→ In network 5, program the call of the 'MC_MOVEABSOLUTE' block with multi-instance as 

shown here.  (→ Instructions → Technology → Motion Control → MC_MOVEABSOLUTE) 
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→ In network 6, program the call of the 'MC_MOVEABSOLUTE' block with multi-instance as 

shown below.  (→ Instructions → Technology → Motion Control → MC_MOVEABSOLUTE) 
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→ In network 7, program the call of the 'MC_MOVEABSOLUTE' block with multi-instance as 

shown here.  (→ Instructions → Technology → Motion Control → MC_MOVEABSOLUTE) 

 

→ Open the 'Main [OB1]' organization block and then call the 'MOTION_CONTROL_ 

MAGAZINE[FB2]‘ function block in network 4. (→ Main [OB1] → MOTION_CONTROL_ 

MAGAZINE[FB2]) 
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→ Create the instance data block as single instance. (→ Single instance → –

MOTION_CONTROL_MAGAZINE_DB → OK) 
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→ Connect the block as shown here and label the network 4. 
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7.12 Downloading the program to SIMATIC S7 CPU 1516F-3 PN/DP 

→ We now save the project once more before downloading the modified and created 'Program 

blocks' to the CPU 1516F-3 PN/DP ' '. (→ →Program blocks →  ) 
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7.13 Diagnostics in the program in SIMATIC S7 CPU 1516F-3 PN/DP 

→ The 'MOTION_CONTROL_MAGAZINE[FB2]' function block can be monitored to diagnose the 

control of the servo drive from the program. Monitoring is activated and deactivated by clicking 

the  icon. (→ MOTION_CONTROL_MAGAZINE[FB2] → ) 

 

→ For diagnostics of the values in the 'PositioningAxis_magazine' technology object, the data in 

the corresponding data block can be accessed in a watch table and in the program.  (→ Add 

new watch table → Watch table_servo_magazine → Technology object → PositioningAxis_ 

Magazine[DB4] →.ActualSpeed → .Position → .ActualPosition→  ) 

 

Note:  

– Read-only access to this data is recommended 
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7.14 Diagnostics in the PositioningAxis_magazine technology object 

→ Various views for diagnostics support are offered under Diagnostics in the 

'PositioningAxis_magazine‘ technology object. We see the 'Status and error bits' view here first. 

Monitoring is activated and deactivated by clicking . (→  Technology objects →  

PositioningAxis_magazine →  Diagnostics → Status and error bits →   ) 

 

  



SCE Learning/Training Document | TIA Portal Module 062-121, Edition 09/2020 | Digital Industries, FA 

 

Unrestricted use in educational / R&D institutions. © Siemens 2020. All rights reserved.                                      81 

sce-062-121-servo-s210-pn-irt-to-s71500-r2008-en.docx  

→ 'Motion status' and 'PROFIdrive telegram' are further views. (→ Motion status → PROFIdrive 

telegram) 
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→ The 'Axis status' and 'Current values' can also be monitored under 'Commissioning' in the 'Axis 

control panel' of the 'PositioningAxis_magazine' technology object. (→ Technology objects → 

PositioningAxis_magazine → Commissioning → Axis control panel) 
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→ The "Tuning" function supports you in determining the optimum precontrol and gain (Kv factor) 

for position control of the axis. For this purpose, the velocity characteristic of the axis is 

recorded during a configurable positioning movement with the Trace function. You can then 

evaluate the recording and adapt the precontrol and gain accordingly.  

(→ Technology objects → PositioningAxis_magazine → Commissioning → Tuning) 

 

 

Note:  

– Before tuning is carried out, 'One Button Tuning' should be performed in the drive. 

 
 

7.15 Diagnostics with SINAMICS Startdrive for servo drive S210 

→ 'Active alarms' and 'Active faults' can be displayed in the frequency converter. You can find 

them under 'Online & Diagnostics'. You can click the  icon to view them in the alarm 

view and acknowledge them there by clicking on the ' ' icon. (→  → Drive_S210… 

→ Online & Diagnostics → Diagnostics → Active alarms →  → ) 
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→ You can see important values of the servo drive under 'Actual values'. (→ Drive_S210… → 

Online & Diagnostics → Diagnostics → Actual values → Actual values) 
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→ The 'Status bits' of the servo drive can also be monitored here.  

(→ Drive_S210… → Online & Diagnostics → Diagnostics → Actual values → Status bits) 

 

→ The 'Safety Integrated function status' is also displayed here under 'Diagnostics'.  

(→ Drive_S210… → Online & Diagnostics → Diagnostics → Safety Integrated function status) 
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→ The telegram data of the communication can be monitored in 'Receive direction' and in 'Send 

direction'. (→ Drive_S210… → Online & Diagnostics → Diagnostics → PROFINET interface 

→ Communication → Send direction → Receive direction) 

 

→ Parameter values can also be monitored online in the 'Parameter view' and the 'Function view' 

of the 'Parameters'. (→ Parameters → Function view → Parameter view) 
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→ States and actual values can be monitored in the 'Control panel' under 'Commissioning'. (→ 

Commissioning → Control panel) 
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7.16 Archiving the project 

→ Finally, the complete project will be archived. Select → 'Project' → 'Archive …' in the menu. 

Open a folder in which you want to archive your project and save your project as the file type 

'TIA Portal project archive'. (→ Project → Archive → TIA Portal project archive → 062-121-

servo-s210-irt-to-s7-1500… → Save) 
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7.17 Checklist 

No. Description Checked 

1 
Servo drive system SINAMICS S210 created in the TIA Portal and 

assigned parameters with SINAMICS Startdrive. 
 

2 
Servo drive system SINAMICS S210 successfully tested via control 

panel. 
 

3 
Servo drive SINAMICS S210 of the CPU1516F-3 PN/DP assigned as 

IRT device. 
 

4 'TO_PositioningAxis' technology object created in CPU1516F-3 PN/DP.  

5 
Device configuration with the servo drive SINAMICS S210 as IRT device 

downloaded successfully to the CPU1516F-3 PN/DP. 
 

6 Device name assigned to the SINAMICS S210 servo drive.  

7 Technology object successfully tested via control panel.  

8 
'MOTION_CONTROL_MAGAZINE ‘[FB2] function block created and 

called in Main [OB1]. 
 

9 
Program blocks successfully compiled and downloaded without error 

message. 
 

10 Press 'Acknowledge‘-button (-S10 = 1) briefly to acknowledge errors.  

11 
Drive the magazine to the fixed stop with the 'Jog' down button (-S12 = 

1). 
 

12 
Perform homing to the position of the fixed stop using the 'Home position' 

button (-S13 = 1). 
 

13 

Now, the desired position can be approached with the  

Start positioning to Position 00 (-S14 = 1) 

Start positioning to Position 01 (-S15 = 1) 

Start positioning to Position 02 (-S16 = 1) 

buttons. 

 

14 Project archived successfully.  
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8 Additional information 

 

More information for further practice and consolidation is available as orientation, for example: 

Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software / 

firmware, under the following link:   

 

Drives 

 

"Further Information" preview  

 

 

https://new.siemens.com/global/en/company/sustainability/education/sce/learning-training-documents/drives.html
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Further Information 
 

Siemens Automation Cooperates with Education 
siemens.com/sce 

SCE Learning/Training Documents 

siemens.com/sce/documents 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

TIA Selection Tool 

siemens.com/tia/tia-selection-tool  

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Product catalog and online ordering system Industry Mall  
mall.industry.siemens.com 
 
 
 
Siemens 

Digital Industries, FA 

P.O. Box 4848 

90026 Nuremberg 

Germany 

 

Subject to change and errors 
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